DilaSoft for Windows Dilatometer Correction Files
Preliminary Documentation: 10/26/98
Updated 11/05/98 for Single push rod system.
Updated 12/22/98 for cooling segments.
Updated 01/05/99
Updated 05/11/00
Updated 06/07/00 for heating/cooling correction files.
DilaSoft for Windows now supports data correction files for Dilatometer instruments. These files,
once created, greatly enhance the accuracy of the instruments by correcting for differences in the
materials used in specimen holders, push rods, etc.
The correction files are created by the user on their own instrument, guaranteeing accuracy by
using the exact setup that will be running the later experiments. They can be recreated any time
there is a change in the instrument, such as a specimen holder or push rod replacement. There is a
single correction file for each ramp rate used in the temperature program. The correction file must
be used with the same type of segment (heating or cooling) as was used to create it. For example;
the correction file was created using a 5 degree heating segment. This file will not be accurate
with a 5 degree cooling segment!
The software will try to match a correction file to every ramp rate used in a temperature program,
segment by segment. Therefore correction files must be created for each separate ramp rate that
will be used in the experiments. If a matching correction file is not found during an experiment, no
correction will be applied for that ramp rate/segment and the experiment will continue.

By default, the correction files are placed in the preset data directory (set from the files-directory
settings menu). The files may be left there or moved into the main program directory (usually
"c:\tw32"). The software will look in both directories for the files. However the data directory
does take priority if two correction files have the same name but reside in the two separate
directories. Moving the files into the main program directory is useful in cases where the data
directories are cleared out or archived as this would also remove the correction files.
Following is an explanation of how to create and use correction files. The examples use a ramp
rate of one degree per minute. Creating other files is done exactly the same way by substituting
other ramp rates in the temperature program segment and associated filenames.
Notes are provided for the differences in single push rod systems.

Creating Correction Files for Theta Dilatometers
Brief Explanation.
Preliminary instructions: 10/26/98
Updated 11/05/98 for Single push rod system.
Updated 12/22/98 for cooling segments.
Updated 01/05/99
Updated 05/11/00 for cooling segments
Updated 06/07/00 for heating/cooling correction files.
Basic setup and procedure:
Make sure the instrument is calibrated, then set up the instrument as for a standard experiment.
Create a one segment temperature program at the desired ramp rate.
Set up the experiment making sure that:
"Use maximum length" if off.
"Use reference temperature" is off.
"Use correction file" is off.
The specimen/reference materials are known.
Both specimen and reference materials are correct length.
Name the data file according to the ramp rate.
Note for single push rod system: the reference material is the same as the specimen holder and can
not be changed. The reference length is the same as the specimen length and can not be changed.
Start the experiment and let it run to the end.

Creating Correction Files for Theta Dilatometers
Detailed setup and procedure:

Set up the instrument:
Make sure that the instrument is set up correctly before starting the experiment as the accuracy of
the correction file depends entirely on the quality of the instrument setup. Careful attention must
be given to specimen/reference and thermocouple positioning. Also check push rod alignment and
pressure against the specimen/reference materials. The instrument must be accurately calibrated.
Create a one segment temperature program for the desired ramp rate: ( sample temperature
programs are supplied with new installations titled: ramp01.set, ramp02.set, etc.)
Select the correct ramp rate for the correction file: here we are using one degree per minute.
Enter the Program tab of the main menu and select Change.
Select New at the top of the page.
Click on the first line of the blank temperature program and enter the data as follows:

Ramp at 1 degree per minute to 1000 degrees; hold for 10 minutes; storage interval of 5 seconds;
log data.
The ramp rate must coincide with the data filename for the correction file. Here we are setting up
a correction file for a one degree ramp. The data file name must be "ramp01.prn" and the ramp
rate must be set at "1". The temperature target will depend on the furnace, specimen holder, push
rods, thermocouples and specimen/reference material. It should be set higher than the normal
target temperatures to be run in standard experiments, but can not exceed the maximum
temperature of the instrument.
The hold time is set to 10 minutes to allow the specimen to catch up to the furnace temperature
and stabilize. This is very important at faster ramp rates. The value needed will depend on the
ramp rate, furnace, specimen holder, etc.

The data interval is set at 5 seconds to capture as much data as possible for a more accurate file.
Log Data is set to on or else no data will be collected.
Once all the values are correctly set, select the Okay button to save the current segment. Then
select the Save As button to save this temperature program as "ramp01.set" and make sure it is
the selected program for the experiment setup!
Note: For correction files that run from a high temperature to a low temperature (cooling): The
instrument can be heated to the high temperature using a first segment that does not log data. The
second segment would then cool the instrument at the desired ramp rate and does log data. This
correction file will be built using only the cooling data. A correction file can not be created by a
temperature program that has both heating and cooling segments that log data!
Important: See the note at the end of this document for more information about cooling data
correction files!

Main Experiment setup:
Enter the Main tab and select the Change button to set up the experiment as follows:

Select the temperature program that was just created, "ramp01.set".
Select a new data filename as "ramp01.prn". This MUST be correctly set according to the ramp
rate! The file names are created as starting with the word "ramp", followed by the actual ramp
rate as "01", followed by the standard ".prn" file extension. The ramp rate must be two numbers
with rates of 1 to 9 preceded by a zero (0). Rates above 9 (10, 11, 12, etc.) are NOT preceded by
a zero (e.g.. "ramp13.prn"). Only integer values are allowed, therefore a ramp rate of 2.5 is not
valid!
Select the known materials for the specimen and reference. Ideally this would be the same
material, both in description and in physical quantity (a single piece of reference material against
both push rods). See materials note below.
Note for single push rod system: The reference material can not be selected here and is set by the
material type of the specimen holder in Configuration. As there is only one push rod, a single
specimen would be placed and selected.

Enter the exact measured length of the specimen/reference materials. The selected length of the
specimen/reference materials should be as close as possible to the lengths of the future experiment
specimen samples. The closer these lengths match, the more accurate the correction file will be in
the experiments.
Note for single push rod system: The length of the reference material is considered the same as
the specimen length and can not be changed.
Make sure that "Use correction file" is NOT checked!
Make sure that "Use reference temperature" is NOT checked!
Make sure that "Use max len" is NOT checked!
Select the Save As button to save this experiment, here as "testramp.exp". For future reference,
names describing the ramp rates could be used such as "ramp01.exp".

Now that all the data has been entered and the temperature program set and selected, the
experiment can be started.
Allow the experiment to run through to the end. Once completed, the correction file for the
selected ramp rate is created and can be used in future experiments by simply checking the box
labeled Use Correction File.

Using the correction files:
When setting up a new experiment, simply check the Use Correction File box in the experiment
setup screen. The files matching the ramp rate in the current segment of the temperature program
will automatically be used as the experiment is run. All collected and calculated data is processed
with the correction file. However, for reference purposes, the uncorrected absolute position is
saved in the last column of the data file.
Most experiments are run using more than one ramp rate in multiple segments of the temperature
program. DilaSoft for Windows will try to match the current ramp rate with a correction file. If a
corresponding correction file is found, those values will be used. If not, no correction is made and
the experiment continues. Therefore, correction files must be named "rampxx.prn" where the "xx"
corresponds to the integer value of the current ramp rate.
If correction files are made from cooling data, make sure they are not used with heating
temperature programs! The correction files will work with either heating or cooling segments,
however the data will only be accurate for the same type of segment that was used to create the
correction file.

Materials Note: Normally the specimen and reference materials are known types to calibrate and
create the correction files. However, the specimen material could be chosen as a user created type
(select "unknown") to produce data and correction files that will compare the difference of new
materials to a selected "standard" material. Using a correction file created with the "unknown"
specimen would produce a data file with zero expansion when run with that same specimen. This
may be useful to companies that produce materials and want to see the differences in production
runs.
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Special Note about Cooling Data Correction Files:
Although correction files can be created and used for cooling cycles, special consideration must
be given to their creation and use. If a correction file is created as specified above, it can only be
used for an experiment that follows the exact same temperature program settings. For example:
A standard cooling correction file is created using a two line temperature program as follows:
1: Ramp at 1 degree to 1000 degrees and hold for 5 minutes, do not log data.
2: Ramp at 1 degree to 20 degrees and hold for 5 minutes, log data.
The resulting correction file will be valid for use only when using the exact same format in the
temperature program as for the experiment! Data logging can not take place before the instrument
reaches 1000 degrees.
The reason for this is that the software will calculate zero expansion at the first segment that logs
data. In this example, no data is logged in the first segment. When the second segment is reached
at 1000 degrees, zero expansion is calculated and used as the reference point to the end of the
experiment. So the correction file created from this temperature program will have a zero
correction factor at 1000 degrees and will not be valid if data is logged during the experiment
before 1000 degrees and it being a cooling cycle.

Creating correction files for heating/cooling experiments:
If the user wishes to use correction files in both heating and cooling cycles in the same
experiment, the following procedure must be followed: Also see the next section!
First, the correction file must be created for this type of experiment and must have zero expansion
at the end of the cooling cycle instead of the beginning. To accomplish this, the following
example temperature program must be used:
1: Ramp 0 degrees to 20 degrees and hold for 0 minutes, log data.
2: Ramp 1 degree to 1000 degrees and hold for 5 minutes, NO log data.
3: Ramp 1 degree to 20 degrees and hold for 5 minutes, Log data.
In this example, the 20 degrees is an arbitrary ‘room temperature' and can be changed. The first
segment must log data to disable the software’s feature of zeroing the expansion at 1000 degrees
when the first data logging segment is reached. Only a single data point must be logged. The
second segment heats up the instrument to the desired temperature and does not log data as this
would be heating data and not wanted. The third segment cools from 1000 degrees down to 20
degrees and logs data to create the cooling correction file data.

Due to the way correction files currently work, the heating and cooling correction files used in the
same experiment must have different ramp rates. For example: A heating correction file can be
used ramping at 4 degrees per minute. In the cooling cycle, a cooling correction file must be used
with a different ramp rate, say 3 or 5 degrees per minute. See note below as this has changed!
A sample experiment temperature program would look like:
1: Ramp at 4 degrees to 1000 degrees and hold for 5 minutes, log data.
2: Ramp at 3 degrees to 20 degrees and hold for 5 minutes, log data.
This example is for the actual experiment. The corresponding correction files for heating at 4
degrees per minute and cooling at 3 degrees per minute would have been previously created.

Another method to create heating/cooling correction files:
Since the change to the new filenames (see note below), correction files using the same ramp rate
are now allowed. There is another method to create heating/cooling files. Use a temperature
program that heats the specimen at the specified ramp rate and then cools at the same rate. For
example:
1: Ramp at 4 degrees to 1000 degrees and hold for 5 minutes, log data.
2: Ramp at 4 degrees to 20 degrees and hold for 5 minutes, log data.
This will create a data file that contains both the heating and cooling ramps. Now load this stored
data file into the analyze program. The entire data set will be seen. Scroll down to the point where
the temperature reaches 1000 degrees and highlight the next line. Do this by clicking the row
number on the left side of the worksheet, the entire row will be highlighted. Scroll down to the
last row. Hold down the SHIFT key and click on the last row number. The entire section should
now be highlighted. Now hold down the Ctrl (control) key and hit the DEL or Delete key. The
entire highlighted section should be deleted. If the contents of the selected range is deleted but the
rows still exist, you didn’t hold down the Ctrl key! You can also go to the Edit menu and select
Delete from there. What is left is the heating section of the data file. Go to the File menu and
select Save As. Save this file as ramp04h.prn. The ramp rate was 4 degrees per minute and it is a
heating file.
Now load the original file back into analyze. This time select the second line of the worksheet by
clicking on the row number (row 2). Now scroll down to where the temperature starts to
decrease. Find the row that has the highest temperature, then one row above that. Select that row
by holding down the SHIFT key and clicking on the row number with the mouse. The entire
heating section of the worksheet should now be highlighted. Again, hold down the Ctrl (Control)
key and hit the Delete key. The entire heating section of the worksheet should now be deleted.
Again go to the File menu and select Save As. This time name the file ramp04c.prn. The ramp
rate was still 4 degrees per minute, but this is a cooling file.

This procedure has created two correction files out of a single experiment file. One for heating
and one for cooling, both with the same ramp rate.
When using this procedure, make sure of the temperature ranges before deleting sections. If a
mistake is made, the original file can be reloaded to start again. Also make sure that the original
file is not named the same as the final correction file or it will be overwritten when the correction
file is saved and will not be able to be reloaded.
The reason the second row is selected above for the cooling file is due to a problem in the
worksheet program. It does not allow for the first row to be deleted for any reason. If the first
row is selected, nothing will be deleted. Make sure to start the selection on the second row! This
will not affect the correction file as the software discards the first row of data since this is
normally all zeroes and not true data.

Using correction files for heating and cooling with the same ramp rate.
A change has been made to the correction file handling. Filenames are now supported using the
letters “h” and “c” appended to the correction filename. These correspond to “h”=heating and
“c”=cooling. For example: A correction file that ramps at 4 degrees per minute and is heating
would normally be named: ramp04.prn. The new filename to designate a heating correction file
would be: ramp04h.prn. This change allows heating and cooling correction files to be used with
the same ramp rate. So the cooling correction file for the above example would be: ramp04c.prn.
Correction filenames using the original format do not have to be renamed. The software will look
first for a correction file named to the new format. If non are found, it will search for a correction
file in the old format. If both heating and cooling correction files are to be used with the same
ramp rate, the new format is required!

Contacting Theta Industries, Inc.
If any clarification or further information is needed, feel free to contact Theta Industries, Inc. by
any of the following means:
Web site: http://www.theta-us.com
e-mail: theta@theta-us.com
For DilaSoft for Windows only support or information:
e-mail: rich@bearlycomputing.com
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